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PowerMILL is the leading NC CAM software specialising in the 
manufacture of complex shapes typically found in the toolmaking, 
automotive, and aerospace industries. PowerMILL 2015 R2 offers all 
of the original features of PowerMILL 2015, but with numerous 
improvements. This document describes the most significant 
improvements. 

PowerMILL 2015 R2 contains the following new features and 
enhancements: 

Preparing toolpaths 
 Tool database improvements (see page 4): 

 Database Manager dialog (see page 5) — Create tool tags and 
connection types to make searching for tools easier. 

 Edit Database Tools dialog (see page 10) — Assign connection-
types and tags to selected tools. 

Generating toolpaths 
 Rib machining(see page 13):  

 Rib Pattern mode-toolbar (see page 22) — Sketch the 
centreline of ribs/channels in a mold. 

 Rib Surfaces mode-toolbar (see page 24) — Automatically 
select the walls and base surfaces of the channels associated 
with the sketched centreline of the ribs/channels. 

 Improved collision avoidance (see page 29) — Check for 
collisions against the stock. 

 Drilling enhancements (see page 30): 

 Drilling from the stock (see page 30) — Create drilling 
toolpaths that start at the top of the stock model. 

Summary of new features 
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 Automatic verification enhancements (see page 31) — 
Collision check against the stock model. You can specify the 
type of toolpath generated after detecting a collision. 

 Drilling non-planar surfaces (see page 34) — Calculate a 
drilling toolpath where the top of the drill move is defined by a 
block surface. 

 Enhancements to area clearance and Vortex drilling (see page 
34) — Specify the diameter of pre-drilled holes before 
machining area clearance toolpaths 

 Editing orientation vectors (see page 36): 

 Specify Changes tab (see page 36) — Edit orientation vectors 
in a restricted toolpath region, without modifying the tool 
axis. 

 Machine axis control tab (see page 37) — Fine-tune orientation 
vectors using Cartesian coordinates. 

 Curve fitting toolbar (see page 38) — Convert selected curve 
segments to a spline. You can also choose to keep curves 
embedded. 

 Machine Tool Simulation Issues dialog (see page 41) — Display a 
list of issues and warnings, with options for collision checking 
and clearance values.  

 Maintaining tool speed after ramping (see page 42) into the 
stock. 

 Aligning the tool with the toolpath (see page 43) — Align the tool 
axis direction with the toolpath. 

 Undo toolpath limit (see page 44) — Undo the last point added to 
a limiting polygon. 

Verifying toolpaths 
 Simulating tool changes (see page 46) — Simulate the tool 

change cycle of a machine tool. 

Outputting toolpaths 
 Verifying NC programs (see page 47): 

 NC program verification dialog (see page 48) — Verify all of 
your NC programs at the same time and display issues and 
warnings in a new dialog. 

 NC program errors in the Explorer (see page 51) — Display 
any issues and warnings associated with NC programs in the 
Explorer. 

 Creating a new tool after toolpath verification (see page 52) — 
Always create a non-colliding tool after a collision. 



 

PowerMILL 2015 R2 What's New Summary of new features • 3  

User interface 
 Customise Keyboard Shortcuts dialog (see page 53) — Create 

keyboard shortcuts to perform PowerMILL commands without the 
use of a mouse. 

 Adding expressions to custom toolbars (see page 56). 

 Select Concave Radii dialog (see page 58) — Select concave or 
convex areas of the model. 

 Editing the width of the toolpath (see page 60) — Edit the display 
width of the toolpath in pixels. 

Automating PowerMILL 
 Macro enhancements (see page 61) — Display entities and hide 

GUI items when you use mode toolbars. 

 Macro Debugger enhancements (see page 62) — Edit variable 
assignments in the Macro Debugger dialog. 
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PowerMILL 2015 R2 contains the following changes and 
improvements to the preparation of toolpaths: 

 Tool database improvements (see page 4): 

 Database Manager dialog (see page 5) — Create tool tags and 
connection types to make searching for tools easier. 

 Edit Database Tools dialog (see page 10) — Assign connection-
types and tags to selected tools. 

 

Tool database improvements 
To make it easier to search the Tool and Holder databases, you can 
create and assign tool tags and connection-types to tools and 
holders. You can then search for tools based on their tags and 
connections.  

 Use the new Database Manager dialog to create a tool tag or 
connection (see page 5). 

 Use the new Edit Database Tools dialog to assign the tool tag or 
connection (see page 10). 

The tool Database Manager dialog controls all database settings. This 
includes the General and Database settings that were previously 
displayed on the Tools > Database page of the Options dialog. 

 

Preparing toolpaths 
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Database Manager dialog 
Use the tool Database Manager dialog to control all database 

settings. To display the Database Manager click  on the Tool 
toolbar. 

 
There are several pages associated with the Database Manager 
dialog: 

 General — Settings to determine how the tool database loads and 
creates tools. Previously these options were available on the 
Tools > Database page of the Options dialog. 

 Database Settings — Settings to determine the location of the tool 
database. Previously these options were available on the Tools > 
Database page of the Options dialog. 

 Tags (see page 5) — Settings to create and edit a tool tag which 
enables you to group tools into categories according to a 
common feature. 

 Connections (see page 9) — Settings to create and edit a tool 
holder connection-type which enables you to group tool holders 
by the shape or material of the join between the machine tool 
and tool holder. 

 

Database Manager > Tags 
Use the Tags page to list the existing tool tags and to create, edit, 
and delete tags. Tool tags group tools according to a common 
feature, for example, strategy type. This enables you to search the 
tool database more easily. First add a tag to the tool database and 
then assign it to a tool.  

 
To add a tool tag to the tool database: 
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1 Click  on the Tool toolbar to display the Database Manager 
dialog. 

 
2 In the tree, select Tags to display the Tags page. 

 
3 Create a tag: 

a Double-click Add Tag. 
b Enter a tag name.  

 
c Press the Enter key to display the tag in the list.  

d Click Close. 

 To delete a tag, on the Tags page of the Database Manager 
dialog, select a tag from the list and click . 

 

Searching the tool database using tool tags 
You can search for tools in the tool database using tool tags. This 
makes it easier to find tools. 

To search for a tool tag: 
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1 Click  on the Tool toolbar to display the Tool Database Search 
dialog. 

 
2 Select Tool Tags. 

 

3 In the Tool Tags area, click  to display the Select Tags dialog. 
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4 Click a tag to select it, for example, Rough. 

 

 Press and hold down the Ctrl key to select multiple tags. 

If you select more than one tag, all the tools with matching 
tags are displayed.  

5 Click Apply.  

6 Click Search. 

Tools with a Rough tag are displayed in the Search Results area. 

 

 To display all results in the Search Results area, click Reset. 
7 Click Close. 
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Database Manager > Connections 
Use the Connections page to list the existing tool holder connection-
types and create, edit, and delete them. Connections describe the 
type of join between a machine tool and a holder. For example, a 
connection may identify the material present at the join, or the 
shape of the join. This enables you to match a machine tool and a 
holder more easily. Connection types are added to the database and 
then assigned to a tool or holder. 

 
To add a connection to the database: 

1 Click  on the Tool toolbar to display the Tool Database Manager 
dialog. 

 
2 In the tree, select Connections to display the Connections page. 

 
3 Create a Connection: 

a Double-click Add Connection. 
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b Enter a connection name, for example Foam. 

 
c Press the Enter key to display the connection in the list.  

4 Click  to close the dialog. 

 To delete a connection, on the Connections page of the 
Database manager dialog, select a connection from the list 

and click . 
 

Edit Database Tools dialog 
Use the tool Edit Database Tools dialog to assign connection-types 
and tags to the selected tools. 
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To display the Edit Database Tools dialog, select a tool from the 
Search results list in the on the Tool Database Search dialog, and 

click . 

 

 

 — Hover over this button to display the tool or tools that you are 
editing. 

Connection — Select the connection-type you want to assign to a 
tool or holder in the database. 

Tags — Displays the tags assigned to a selected tool. 

 — Click to remove a selected tag from the database. 

Add Tags — Select the tags that you want to assign to a tool in the 
database. 

 — Click to assign a selected tag to the tool. The tag is then 
displayed in the Tags list. 

 — Click to display the Database Manager dialog (see page 5). 
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PowerMILL 2015 R2 contains the following changes and 
improvements to the generation of toolpaths: 

 Rib machining (see page 13): 

 Rib Pattern mode-toolbar (see page 22) — Sketch the 
centreline of ribs/channels in a mold. 

 Rib Surfaces mode-toolbar (see page 24) — Automatically 
select the walls and base surfaces of the channels associated 
with the sketched centreline of the ribs/channels. 

 Improved collision avoidance (see page 29) — Check for 
collisions against the stock. 

 Drilling enhancements (see page 30): 

 Drilling from the stock (see page 30) — Create drilling 
toolpaths that start at the top of the stock model. 

 Automatic verification enhancements (see page 31) — 
Collision check against the stock model. You can specify the 
type of toolpath generated after detecting a collision. 

 Drilling non-planar surfaces (see page 34) — Calculate a 
drilling toolpath where the top of the drill move is defined by a 
block surface. 

 Enhancements to area clearance and Vortex drilling (see page 
34) — Specify the diameter of pre-drilled holes before 
machining area clearance toolpaths 

 Editing orientation vectors (see page 36): 

 Specify Changes tab (see page 36) — Edit orientation vectors 
in a restricted toolpath region, without modifying the tool 
axis. 

 Machine axis control tab (see page 37) — Fine-tune orientation 
vectors using Cartesian coordinates. 

Generating toolpaths 
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 Curve fitting toolbar (see page 38) — Convert selected curve 
segments to a spline. You can also choose to keep curves 
embedded. 

 Machine Tool Simulation Issues dialog (see page 41) — Display a 
list of issues and warnings, with options for collision checking 
and clearance values.  

 Maintaining tool speed after ramping (see page 42) into the 
stock. 

 Aligning the tool with the toolpath (see page 43) — Align the tool 
axis direction with the toolpath. 

 Undo toolpath limit (see page 44) — Undo the last point added to 
a limiting polygon. 

 
 

Ribs 
The new Rib machining strategy enables you to machine narrow 
channels in a mold (see page 14). For example, you can machine 
narrow grooves in a mold tool that form ribs in the resulting 
injection moulded part. Rib machining is located in the new Ribs 
category on the Strategy selector dialog. 

 
For more information on the rib machining strategy, see: 

 Rib Machining Overview (see page 14) — An introduction to rib 
machining. 

 Rib machining — Machine channels in a mold which form ribs in 
the resulting injection-molded part. 

 Automatic verification — Enable verification of toolpaths on 
creation. 
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 Rib Pattern mode-toolbar (see page 22) — Sketch the centreline 
of ribs/channels. 

 Rib Surfaces mode-toolbar (see page 24) — Automatically select 
the walls and base surfaces of the channels associated with the 
sketched centreline of the ribs/channels. 

 Creating a rib machining toolpath (see page 25) — Create a rib 
machining toolpath. 

The common tabs are described in common toolpath creation 
controls. 

For more information on the Strategy Selector dialog, see Toolpath 
Strategies. 

 

Rib Machining Overview 
Use the Rib Machining strategy to machine channels in a mold which 
form ribs in the resulting injection-molded part. Typically, the 
channels are long, thin, and non-planar. 

Rib machining requires: 

 a pattern that is an approximate centreline of the channel. 

 surfaces defining the walls and the base of the channel. 

 a tool that fits inside the channel. The width of the channel must 
be between one and four times the diameter of the tool. 

Rib machining frequently uses a form tool that reflects the exact 
shape of the channel. 
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The pages associated with the Rib Machining strategy are: 

 
 Rib machining (see page 16) — The main page used to define a 

rib machining toolpath. 

 Automatic verification — Settings to automatically verify the 
toolpath when calculating it. 

The remaining pages are common toolpath creation controls. 
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Rib machining 
Use the Rib machining page to create a toolpath by machining a 
channel (or groove) in a part. 

 
Pattern — Select the pattern that is the approximate centreline of 

the channel. If you do not have a suitable pattern, click  to 
sketch one. 

 Rib pattern — Click to display the Rib Pattern mode-toolbar which 
enables you to sketch the approximate centreline of the channel 
(see page 22). 

Surfaces — Select the surfaces forming the walls and base of the 

channel. Alternatively, click  to select these surfaces 
automatically. 

 Rib surface — Click to display the Rib Surface mode-toolbar 
which enables automatic selection of the wall and base surfaces of 
the channel (see page 24). 

Style — Select whether you want to machine down both walls of the 
channel or down the centreline. 
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Selecting a Style of Rib walls creates a toolpath that machines 
down one side of the channel and then the other side. Use this 
option when the tool is smaller than the channel. 

 
Selecting a Style of Rib centre creates a toolpath that machines 
down the centreline of the channel. Use this option when the 
tool, frequently a form tool, is the size and shape of the channel. 
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Clearance — When the top surface is not fully machined, enter the 
height above the top of the top of the channel where the machining 
starts. 

For example: 

A Clearance of 0 gives: 

 
A Clearance of 10 gives: 

 
Offset — Select how to offset from the base surface to the top of the 
channel. 
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Merge — When selected, starts by offsetting the base profile and 
migrates the offset so that at the end it is offsetting the top 
profile. This minimises the number of air moves. 

 
Offset up — When selected, offsets the base profile. This option 
gives a consistent depth of cut and minimises the number of 
downhill moves. This is important when your tool cannot make 
cutting moves where Z decreases. 

 

  Region with no downhill moves 

  Region with downhill moves. 

 You can eliminate the downhill moves by selecting a Cut 
direction of Uphill. 

Tolerance — Enter a value to determine how accurately the toolpath 
follows the contours of the model. 

Cut direction — Select the milling technology. 
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Climb — Select to create toolpaths using only climb milling, 
where possible. The tool is on the left of the machined edge 
when viewed in the direction of tool travel. 

Conventional — Select to create toolpaths using only 
conventional or upcut milling, where possible. The tool is on the 
right of the machined edge when viewed in the direction of tool 
travel. 

Any — Select to create toolpaths using both conventional and 
climb milling. This minimises the tool lifts and tool travel. 

Pattern — Select to create a toolpath that follows the direction of 
the pattern. This option uses both climb and conventional milling. 
When you select a Style of Rib walls, one wall is machined using 
climb milling and the other using conventional milling to ensure 
the tool follows the direction of the pattern. With open channels, 
use this option to start machining from the open end of the 
channel to avoid plunge moves. To see the direction of the 

pattern, instrument it by clicking  on the Rib Pattern mode-
toolbar.  

 Display the Rib Pattern mode-toolbar by clicking . 

Uphill — Select to create a toolpath that avoids cutting moves 
where Z decreases. This option uses both climb and conventional 
milling. When you select a Style of Rib walls, one wall is 
machined using climb milling and the other using conventional 
milling to ensure the tool never makes a decreasing Z move. 
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 additional toolpath lifts added to avoid cutting moves where Z 
decreases 

Machine with tool taper angle — When selected, the tool machines 
the channel using its taper angle instead of the draft angle of the 
channel. This is useful when the channels are not modelled 
accurately, do not need to be machined accurately, or you have a 
form tool that matches the profile of the channel. 

Angular tolerance — Enter the maximum deviation from the draft 
angle of the channel to the tool taper angle. When this angle is 
exceeded, PowerMILL leaves a portion of the channel unmachined. 

Thickness — Enter the amount of material to be left on the part.  

 Component thickness — Click to display the Component thickness 
dialog, which enables you to specify the thicknesses of the different 
surfaces. 

Max stepdown — Enter the maximum distance between successive 
passes. 

 

 Copy stepdown from tool — Click to load the axial depth of cut 
from the active tool's cutting data. The axial depth of cut is 
measured along the tool axis. 

 Copy stepover from tool — Click to load the radial depth of cut 
from the active tool's cutting data. The radial depth of cut is 
measured normal to the tool axis. 

 If you enter the value manually, the button changes to . 

Order — Select the machining order of the selected channels. 
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Pattern — Select to machine the channels in the same order as 
you created the pattern. 

Shortest — Select to create the shortest toolpath. This minimises 
the air moves. 

 

Rib Pattern mode-toolbar 
Use the Rib Pattern mode-toolbar to sketch the centreline of 
ribs/channels. 

The Rib Pattern mode-toolbar is available from the Rib pattern  
button on the Rib Machining strategy dialog (see page 14). 

 

 Activating a mode disables most of PowerMILL's functionality 
until you exit from the mode. For more information, see 
Mode-toolbars. 

 Lines — Hover to display the Line toolbar which creates new 
lines. You can define the lines either interactively or by entering the 
required coordinates. This is similar to the Line toolbar available on 
the Curve Editor mode-toolbar. 

 

 Continuous line — Click to create a continuous line containing 
straight line segments. 

 

 Close Segment — Click to close the current segment. 

It converts an open segment: 
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To a closed segment: 

 

 Start New Segment — Click to end the current segment so the 
next point is the start of a new segment. 

 Finish — Click to accept the changes and close the toolbar. 

For more information, see the create lines example. 

 Single line — Click to create a single line. 

 Delete — Click to delete the selected items, curve segments, 
workplanes, or points. 

 Reverse — Click to reverse the direction of the selected items. 

Converts this: 

 
to this: 

 

 You must select the segments you want to reverse. 

 Reorder segments — Click to list all the curve segments and 
enables you to change the order of the segments in a pattern. 

 Cut — Hover to display the Cut toolbar which cuts or merges 
curves. 

 

 Curve Editor — Click to display the Curve Editor mode-toolbar, 
which enables you to create and edit patterns. The assumption is 
that you first extract curves from the model, by say, extracting 
curves at surface boundaries, and then modify the curve to create 
the exact pattern you need. 
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 Instrument — All curves have a direction. If you instrument a 
curve, it places an arrow on each segment (pointing towards the 
end of the segment) and an X at the end of each segment. 

 

 Undo — Select to revert to what it was before the last change. 

 Redo — Select to reinstate the edit you have just undone. 

 Next — Click to create the sketched pattern, close the Rib Pattern 
mode-toolbar and open the Rib Surface mode-toolbar (see page 24). 

 Accept changes — Click to accept and keep all the created 
curves. This closes the Rib Pattern mode-toolbar and enables normal 
PowerMILL functionality. 

 Cancel changes — Click to delete all the created curves. This 
closes the Rib Pattern mode-toolbar and enables normal PowerMILL 
functionality. 

 
 

Rib Surfaces mode-toolbar 
Use the Rib Surfaces mode-toolbar to automatically select the walls 
and base surfaces of the channels associated with the sketched 
centreline of the ribs/channels. 

The Rib Surfaces mode-toolbar is available from the Rib surfaces  
button on the Rib Machining strategy dialog (see page 14). 

 

 Activating a mode disables most of PowerMILL's functionality 
until you exit from the mode. For more information, see 
Mode-toolbars. 

 Find rib surfaces — Click for PowerMILL to automatically find the 
rib/channel surfaces associated with the centreline pattern. 
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 Select a pattern on the Rib machining dialog to enable this 
functionality. 

 Select surfaces — click to manually select the rib/channel 
surfaces associated with the centreline pattern. 

 For example, use  to select the majority of the surfaces 

and then use  to select or deselect the final few surfaces. 

 Undo — Select to revert to what it was before the last change. 

 Redo — Select to reinstate the edit you have just undone. 

 Previous — Click to close the Rib Surfaces mode-toolbar and 
return to the Rib Pattern mode-toolbar (see page 22). 

 Accept changes — Click to accept and keep all the created 
curves. This closes the Rib Pattern mode-toolbar and enables normal 
PowerMILL functionality. 

 Cancel changes — Click to delete all the created curves. This 
closes the Rib Pattern mode-toolbar and enables normal PowerMILL 
functionality. 

 

Creating a rib machining toolpath 
This example shows you how to create a rib machining toolpath. 
This uses the Ribs_multi.dmt model in the Examples folder and a 
simple rectangular block. 

 
In this example the ribs are far wider than in a typical ribbed model 
as this makes it easier to understand the process. 
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1 Create a tapered spherical tool with: 

a A Diameter of 25. 

b A Tip radius of 7. 

c A Taper angle of 25. 

d A Length of 125. 

2 Click the Toolpath Strategies  button,  

3 From the Ribs category select Rib Machining. This displays the 
Rib Machining dialog. 

 

1 Click the Rib pattern  button to display the Rib Pattern mode-
toolbar. This is a simplified version of the Curve Editor mode-
toolbar. 
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This automatically changes the view to the view down Z. 

 

2 Click the Line  button on the Line toolbar . 

3 Sketch the approximate centreline of the four channels as four 
lines. For complete machining of each channel, the lines must 
extend beyond the open end of the channels. The direction of 
each line determines the machining direction. Because most rib 
machining tools break when plunging, it is best to start each line 
from the open end of the channel. 

 

4 If you can't see the direction of the lines, click Instrument . 
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5 Click Next  to display the Rib Surfaces mode-toolbar. 

 

6 Click the Find rib surfaces  button. This automatically selects 
all the wall and base surfaces of the channel. 

 

7 Click . This closes the Rib Surfaces mode-toolbar and displays 
the Rib Machining dialog. 

 
8 On the Rib Machining dialog: 
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a Select a Style of Rib walls. 

b Enter a Max stepdown of 3. 

c Click Calculate. 

This creates the rib machining toolpath. 

 
 

Improved collision avoidance 
You can collision-check the unmachined stock of area clearance 
toolpaths against the shank and holder. In previous versions, you 
could only collision-check the shank and holder against the model, 
not the stock.  

The following table compares a Model Area Clearance toolpath in 
PowerMILL 2015 R2 and PowerMILL 2015: 

PowerMILL 2015 R2 PowerMILL 2015 
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  No collision   Collision 

To enable this function, select Automatic collision checking on the 
Automatic verification strategy page. 

 
 

Drilling enhancements 
There are several enhancements to drilling. You can: 

 start drilling at the top of the stock (see page 30). 

 check for collisions against the stock model (see page 31). 

 specify the type of toolpath generated after detecting a collision 
(see page 31). 

 drill blocks with a non-planar surface (see page 34). 

 specify Entry moves in Vortex strategies (see page 35). 

 specify the diameter of a pre-drilled hole (see page 35). 

There are also changes to the way in which drilling toolpaths are 
defined (see page 35). 

 

Drilling from the stock 
You can create drilling toolpaths that start at the top of the stock 
model. This enables you to drill holes from the start of the material, 
not the block, which minimises air moves. To create a drilling 
toolpath starting at the top of the stock, you must select the 
following options in the Drilling strategy dialog: 
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1 On the Drilling strategy page, select Stock model from the Define 
top by list. 

 
2 On the Stock page: 

 
a select a Stock Model from the list. 

b select a Stock Model state from the list. This is the state of the 
stock material at a particular point in the machining process. 

If the currently active state in a stock model is a: 

Block — The stock model is the initial state of the stock, before 
any entities are applied to it. 

 Depending on how it is used, an individual Stock Model can 
also be a block. 

Toolpath — The stock model is the state of the stock, after 
applying a toolpath to the stock's previous state. 

Tool — The stock model is the state of the stock after applying a 
dense raster toolpath (automatically created using the tool). 

a enter a value in the Detect material thicker than field. 
PowerMILL ignores rest material that is thinner than the 
specified threshold.  

 

Automatic verification enhancements 
There are several enhancements to the drilling Automatic verification 
page. 
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- 

You can: 

 collision check against the stock model. 

 specify the type of toolpath generated after detecting a collision 
with the model, stock model or block. 

Collision checking against — Displays what is collision checked.  

 The option selected in the Define top by list on the Drilling 
page, determines what is displayed.  

Hole top — Drilling starts at the top of the hole. 

Component top — Drilling starts at the top of the component 
specified in the Top component field rather than the top of the 
hole. This is useful when drilling compound holes. 
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  Hole top, first component top 

  Second component top. 

  Third component top. 

Block — Drilling starts at the top of the block. 

Model — Drilling starts at the top of the model. 

Stock model — Drilling starts at the top of the stock. This displays 
the Stock page in the Drilling strategy dialog. 

Output — Select the type of toolpath generated on detecting a 
collision: 

 Safe and unsafe moves — Generates the whole toolpath including 
the colliding segments.  

 Safe split moves — Splits the toolpath into safe and unsafe 
moves, and only outputs the safe moves. 

 Moves in safe holes only — Generates toolpaths only in collision-
free holes. 
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Drilling non-planar surfaces 
You can calculate a drilling toolpath where the top of the drill move 
is defined by the block surface, including blocks with curved 
surfaces. In previous versions of PowerMILL, this was restricted to 
planar, horizontal block surfaces.  

 
 

Enhancements to area clearance and Vortex drilling 
There are several enhancements to area clearance drilling. In 
PowerMILL 2015 R2, you can specify the diameter of the hole (see 
page 35). There are also changes to the way that drilling toolpaths 
are defined (see page 35). 
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Specifying the diameter of a hole 
You can specify the diameter of pre-drilled holes before machining 
area clearance toolpaths. This enables you to access closed pockets 
without the need for helical ramps, saving you time. The default 
diameter is 150% of the tool diameter; to change this, enter a Hole 
diameter on the Approach page of the area clearance strategy. This 
generates a feature set with the required drilling positions. You 
must then create a drilling toolpath to machine the drilling positions.  

 

 You can also enter hole diameters for Vortex machining. On 
the Approach page of the Model Area Clearance dialog, select 
Drilling holes from the Move type list. Enter a value for the Hole 
Diameter that is greater than the diameter of the tool.  

 
 

Changes to drilling toolpath definition 
PowerMILL 2015 R2 uses feature sets to define drilling positions and 
hole diameters. Using feature sets enables you to generate your 
own drilling toolpath with the appropriate drilling cycles. PowerMILL 
creates the following features when you calculate an area clearance 
toolpath: 

 patterns containing the drilling position 

 features containing the drilling holes 
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Editing orientation vectors 
You can edit orientation vectors in a restricted toolpath region, 
without modifying the tool axis. As the direction of the orientation 
vectors is defined by Cartesian components, you can fine-tune 
orientation vectors, which is useful when using robots.  

These options are available on the following tabs: 

 The Specify Changes tab of the Edit Toolpath Within Region dialog 
(see page 36). Use this to edit only the orientation vectors. 

 The Machine axis control tab of the Tool Axis dialog. Use this to 
define the orientation vectors in Cartesian coordinates. 

 

Specify Changes tab 
The Specify Changes tab (previously named Edit Tool Axis) of the 
Edit Toolpath Within Region dialog includes the following 
enhancements: 

 There is a new Orientation Vector Only option in the Type of Editing 
list. Select this option to edit the orientation vectors without 
modifying the tool axis. 

 
 There is a new Orientation field, which displays the Orientation 

type. 
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 There is a new Orientation  button. Click this button to display 
the Tool Axis dialog and select an Orientation type. Your selection 
is displayed in the Orientation field in the Edit Toolpath Within 
Region dialog.  

 The Edit Toolpath Within Region dialog was previously called 
Tool Axis Editing dialog. 

 

Machine axis control tab 
The Machine axis control tab of the Tool axis dialog includes the 
following enhancements: 

 Components fields — Enter values in the fields to edit the 
machine axis direction by defining a vector using its i, j and k 
components.  

 
To display the Components field, on the Machine axis control 
page: 

a select Orientation vector from the Orientation type list. 
b select Fixed Direction from the in the Orientation vector list.  

 Direction  button — Click to display the Direction dialog, which 
provides additional options to edit orientation vectors. 
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Curve fitting toolbar 
You can now fit a curve after it has been accepted. The new Curve 
fitting toolbar on the Create Composite Curve mode-toolbar enables 
you to convert selected curve segments to a specific type of curve, 
or choose to keep curves embedded. 

 
To display the Curve fitting toolbar:  

 hover over the No curve fitting  button on the Create Composite 
Curve mode-toolbar. 

 select an option from the Curve fitting list in Options > Curve 
Editor. 

You can select: 

 No curve fitting — Click to keep curves embedded. 

 Spline selected — Click to convert the selected segments into a 
spline. This displays the Spline Fit dialog. 

 
Tolerance — Enter the maximum distance between the original and 
fitted curves. The value specified in the Curve Fitting Tolerances 
page of the Options dialog, accessed from the Curve editor options 

 button is available as an option on the drop-down list. 

Spline selected converts this selected curve: 
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To this: 

 

 Arc Fit selected — Click to arc fit selected segments. This 
smooths curves. This displays the Arc Fit dialog. 

 
Tolerance — Enter the maximum distance between the original and 
fitted curves. The value specified in the Curve Fitting Tolerances 
page of the Options dialog, accessed from the Curve editor options 

 button is available as an option on the drop-down list. 

Arc fit selected converts this selected curve: 

 
To this: 
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 Polygonise selected — Click to convert the selected segments to 
a series of straight lines. This displays the Polygonise dialog. 

 
Tolerance — Enter the maximum distance between the original and 
fitted curves. The value specified in the Curve Fitting Tolerances 
page of the Options dialog, accessed from the Curve editor options 

 button is available as an option on the drop-down list. 

Polygonise selected converts this selected curve: 

 
To this: 
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Machine Tool Simulation Issues 
There is a new machine Tool Simulation Issues dialog, which 
replaces the Machine Tool Collisions dialog. Use this dialog to enable 
machine tool collision checking, specify a clearance value around 
the machine tool to identify 'near misses', and review any collisions 
or 'near misses' that occur when simulating and jogging the 
machine tool. 

 
To display the dialog: 

 From the Machine Tool toolbar, click . 

 On the Machine Tool Position dialog, click . 

 In the Explorer, right-click a machine tool and select Issues. 

 — Displays the name of the machine tool. 

Check for Collisions — Click to enable collision checking. 

Machine tool clearance — Enter a clearance value around the 
machine tool that PowerMILL takes into consideration when 
checking for collisions. When a machine tool axis-component and 
the part are within the specified clearance value, the axis-
component is highlighted yellow. 
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 PowerMILL checks for collisions and 'near misses' at fixed 
points. Although these points are distributed frequently, it is 
possible that PowerMILL may not identify small collisions that 
occur in between two points. 

Machine tool collision-checking does not check the tool 
assembly for collisions. To check the tool assembly, use the 
Toolpath Verification function. 

Check the tool and tool holder — Click to enable collision checking of 
the tool and tool holder.  

 If selected, the cutting part of the tool is checked against the 
machine, and the holder is checked against the machine and 
the model. 

Issues found — Displays a chronological list of issues and warnings. 
Click on an issue in the list to move the active machine tool to the 
position where the issue occurs. 

Clear — Click to clear the table of entries. 
 

Maintaining tool speed after ramping 
There is a new option on the Lead feed rates strategy page which 
enables you to maintain the feed rate after ramping into the stock. 
You can also specify the distance that this feed rate is maintained. 
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To maintain the ramp feed rate, in the Ramp lead in area of the Lead 
feed rates strategy page, select Maintain ramp feed rate. Enter the 
distance for which the tool speed is maintained. 

 

Aligning the tool with the toolpath 
There is a new Align tool with toolpath  button on the Dynamic 
machine control mode-toolbar which enables you to align the tool 
with the toolpath. To enter the mode: 

 Click Dynamic machine control  button on the: 

 Tool toolbar 

 Toolpath toolbar 

 Machine tool toolbar 

 In the Explorer, right-click a tool and click Dynamic Machine 
Control. 

 In the graphics area, right-click a tool and click Dynamic Machine 
Control. 

 The mode is available for all tools. All of the mode functions 
are available when you use the following tools: ball nosed, tip 
radiused, end mill, tapered spherical and tapered tip. When 
you use other tools, such as a drill or barrel tool, the mode 
functions are limited. 

Activating a mode disables most of PowerMILL's functionality 
until you exit from the mode. For more information, see 
Mode-toolbars. 

Click Align tool with toolpath  to align the tool axis direction with 
the toolpath. If the tool has a contact point, it is respected. 
However, it is not necessary to have the tool attached to the 
toolpath to realign it. 
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Limit toolpath enhancements 
There is a new undo  button on the Toolpath Limit dialog which 
enables you to undo the last point added to a limiting polygon. 

 
To display the Toolpath limit dialog: 

 on the Toolpath toolbar, select ; or 

 from the individual Toolpath context menu, select Edit > Limit. 
To create a polygon:  

1 Select Polygon from the Limit to list. 

2 Sketch a polygon with any number of sides, using the mouse. 

3 Click Apply. 

To undo the last point added to the limiting polygon, click . 

 



 

PowerMILL 2015 R2 What's New Verifying toolpaths • 45  

PowerMILL 2015 R2 contains the following changes and 
improvements to the verification of toolpaths: 

 Simulating tool changes (see page 46) — Simulate the tool 
change cycle of a machine tool. 

 

Verifying toolpaths 
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Simulating tool changes 
PowerMILL can simulate the tool change cycle of a machine tool. 
This enables you to identify issues with tool changes, such as 
collisions. To display tool changes, use the Simulation toolbar to 
simulate a toolpath or NC program in the same way as in previous 
versions of PowerMILL. If you load an .mtd file, the machine tool is 
automatically displayed. Use the options on the Simulation toolbar to 
control the simulation. If you do not load an .mtd file, the machine 
tool does not load. You can still simulate toolpaths as in previous 
versions of PowerMILL.  

 The tool numbers in each toolpath determine the order of 
simulation. 

 
 

 First tool change 

 Second tool change 

 Robot 

 Model 
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PowerMILL 2015 R2 contains the following changes and 
improvements to the outputting of toolpaths: 

 Verifying NC programs (see page 47): 

 NC program verification dialog (see page 48) — Verify all of 
your NC programs at the same time and display issues and 
warnings in a new dialog. 

 NC program errors in the Explorer (see page 51) — Display 
any issues and warnings associated with NC programs in the 
Explorer. 

 Creating a new tool after toolpath verification (see page 52) — 
Always create a non-colliding tool after a collision. 

 

Verifying NC programs 
The Explorer includes a new option that enables you to verify all of 
your NC programs at the same time. Any errors and collisions are 
displayed: 

 in the new NC program verification dialog (see page 48). Use this 
to view a list issues for each NC program. 

 in the PowerMILL Explorer. 
 

Outputting toolpaths 
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NC program verification dialog 
Use the NC program verification dialog to verify your NC programs. 
To display the NC program verification dialog, from the NC Programs 
context menu, select Verify all. Alternatively, to verify a single NC 
program, from the individual NC program context menu, select 
Verify. 

 

 — Select an NC program to verify.  

 — Click to display the NC program dialog. Use this to view and 
edit the detail of the NC program. 

 — Displays the name of the machine tool. 

 — Displays the name of the workplane. 

Machine tool clearance — Enter the minimum distance between the 
model and the machine tool. If you want to measure this, click 
Machine tool clearance to display the Measure mode toolbar.  
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Verify toolpaths — Select to check for collisions between the tool, 
the holder and the model. 

Increase toolpath clearances — Select to verify toolpaths that 
have been previously verified with lower clearance values. 

Keep existing toolpath clearances — Select not to verify toolpaths 
that have been previously verified with lower clearance values. 

 If you select Keep existing toolpath clearances, warnings are 
still displayed in the Verification list. 

Verify connection moves — Select to include connection moves in the 
verification. This applies to the tool and the model. 

Holder Clearance — Enter the minimum allowable distance between 
the model and the tool holder profile. 

Shank Clearance — Enter the minimum allowable distance between 
the model and the tool shank profile. 

 Click Holder clearance or Shank clearance to display the 
Measure mode toolbar. 

Safety status indicator — Displays an icon which identifies the most 
severe issue found in verification. 

 — Collisions found 

 — Other issues, for example, unverified toolpaths. 

 — Gouge checked 

 — Gouge, and holder checked 

 — Gouge, holder, and machine tool checked 

Verification list — Displays a chronological list of issues and 
warnings. 

Issues are added to the list when: 

 there is a collision between the tool (or the shank, or holder) and 
the model. 

 there is a machine tool collision. 

 the machine tool cannot reach a location. 

 the machine tool exceeds its limits. 

Warnings are added to the list when:  

 a toolpath is not verified. 

 a toolpath could not be verified. 

 a toolpath is verified, but the NC program has higher clearance 
values. 
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 a connection is not verified. 

 the machine tool overlaps with the clearance of another 
component. 

 — Click to display the Machine Tool Position dialog. 

Load Issue — Select an error from the verification list and click Load 
issue to display the error on the model. 

 
 — Click to ignore the selected warnings.In the verification list, 

the selected warning changes from to . 

Verify — Click to refresh the verification of the NC program. This is 
useful when you edit the options in this dialog. 

Close — Click to close the dialog. 
 

Clearing verification 
You can clear verification for the machine tool list and the machine 
tool status for: 

 all NC Programs — From the NC programs context menu, select 
Clear all NC Program verification. 

 a single NC program — From the individual NC program context 
menu, select Clear Verification. 

 This does not change the verification status of the toolpath or 
the model. 
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NC program errors in the Explorer 
The Explorer displays the issues and warnings associated with NC 
programs. Hover over an NC program to display the Safety Status. 

 
The icons display the most severe issue in the NC program: 

Issues are added to the list when: 

 there is a collision between the tool (or the shank, or holder) and 
the model. 

 there is a machine tool collision. 

 the machine tool cannot reach a location. 

 the machine tool exceeds its limits. 

Warnings are added to the list when:  

 a toolpath is not verified. 

 a toolpath could not be verified. 

 a toolpath is verified, but the NC program has higher clearance 
values. 

 a connection is not verified. 

 the machine tool overlaps with the clearance of another 
component. 

 — Collisions found 

 — Other issues, for example, unverified toolpaths. 

 — Gouge checked 

 — Gouge, and holder checked 

 — Gouge, holder, and machine tool checked 
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Creating a new tool after toolpath 
verification 

There is an Always Create New Tool option in the Collision Options 
area of the Toolpath Verification dialog. Select this option to always 
create a non-colliding tool after a collision has been detected. When 
Always Create New Tool is selected, PowerMILL does not search for a 
safe tool in the Tools list as it did in previous versions, it 
automatically creates a new tool with safe properties (overhang, 
cutting length, collision depth). To display the Toolpath Verification 
dialog, select Verify > Toolpaths from the Toolpath context menu. 
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PowerMILL 2015 R2 contains the following changes and 
improvements to the user interface: 

 Customise Keyboard Shortcuts dialog (see page 53) — Create 
keyboard shortcuts to perform PowerMILL commands without the 
use of a mouse. 

 Adding expressions to custom toolbars (see page 56). 

 Select Concave Radii dialog (see page 58) — Select concave or 
convex areas of the model. 

 Editing the width of the toolpath (see page 60) — Edit the display 
width of the toolpath in pixels. 

 

Customise Keyboard Shortcuts dialog 
You can use keyboard shortcuts to perform PowerMILL commands 
without the use of a mouse. Use a combination of keys on the 
keyboard to perform tasks that are usually accessed on toolbars, 
menu bars, or using macros. Keyboard shortcuts comprise either: 

 a function key (F2–F12). 

 You cannot use F1 as this is used to display the Help 
window.  

 a control key (Ctrl, Alt, or a combination of both), and one of the 
following keys: 

 alphanumeric keys— a-z, 0–9, punctuation keys and symbol 
keys. 

 navigation keys — for example, End, Page Up and Insert. 

 You can also use the Shift key in combination with any of the 
above keys. 

User interface 
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Use the new Customise Keyboard Shortcuts dialog to assign 
keyboard shortcuts to commands. To display this dialog, select 
Customise Keyboard Shortcuts from the Tools menu. 

 

 Control selector — Click and drag over a toolbar button. The 
button is selected and displayed in the menu list, and in the Toolbar 
field.  

 While dragging, the mouse changes to  and places a box 
around the selected button. 

 Add macro shortcut — Click to add a new macro to the menu list 
and display the Macro field. 

 Add command shortcut — Click to add a new command item to 
the menu list and display the Command field.  

 Delete — Click to remove a selected shortcut. 

 Import shortcuts — Click to display the Select keyboard 
configuration file to import dialog. This enables you import an 
existing keyboard configuration. 

 Export shortcuts — Click to display the Export keyboard 
configuration to a file dialog. This enables you to save your keyboard 
configuration. 

  Print shortcuts — Click to display a list of your keyboard 
shortcuts in the PowerMILL HTML browser and display the Print 
Preview window. 

 Reset— Click to restore the default keyboard settings.  
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Menu list — expand the: 

 Macros branch to display the file path, with a file selector. 

 Commands branch to display your commands. 

 Menus branch to display a list of PowerMILL menus that you can 
assign a keyboard shortcut to. 

 Toolbars branch to display a list of PowerMILL toolbars that you 
can assign a keyboard shortcut to. 

The Shortcut field displays the file path of the item you selected. 

 The name of the shortcut field changes, depending on 
whether a macro, command, menu or toolbar item is selected. 

Shortcut key — Displays the keyboard shortcut assigned to the 
selected item in the menu list. To create a new keyboard shortcut, 
press a combination of approved keyboard keys and click Assign. 

Current assignment — If a keyboard shortcut entered in the Shortcut 
key field is already assigned to an item in the menu list, this field 
displays the current assignment of that keyboard shortcut. 

Go to item — If a shortcut is displayed in the field, click to locate the 
item in the menu list. 

Assign — Click to assign a shortcut to an item.  

Remove — Click to remove a shortcut from an item. 

Close — Click to close the dialog. 
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Adding expressions to custom toolbars 
There is a new Expressions option in the Edit Custom Toolbar dialog 
that enables you to add expressions to custom toolbars.  

 

 The toolbar automatically updates when you change an 
expression. 

To display the Edit Custom Toolbar dialog: 

1 Select View > Toolbar > Custom> Customise. 
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2 Click  to create a toolbar. 

3 Double-click the toolbar in the list. 

To add an expression to a custom toolbar: 

1 Select Expression from the Type list. 
2 Enter a command, for example tool.diameter. 

 Use the command window to find the command you need. 

3 Enter a description, for example Tool diameter. 

 

4 Click . This adds the menu option to the custom toolbar. 

5 Select View > Toolbar > Custom > Custom1 to display your custom 
toolbar. 
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Select Concave Radii dialog 
Use the Select Concave Radii dialog to select small, concave or 
convex surfaces in a model. To display the dialog, right-click the 
model and select Selection Tools > Select Concave Radii.  

 
The Orient surface options enable you to correctly orient your model. 

Orient all — Click to automatically reverse the orientation of all the 
surfaces which are incorrectly oriented in the current view. 

Orient selected — Click to automatically reverse the orientation of all 
the selected surfaces which are incorrectly oriented in the current 
view. 

Minimum radius — Enter the minimum radius of the concave 
surfaces you want to select. 

Include partially concave components — When selected, selects any 
surface which has a concave region.  
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When deselected, any surface which is wholly concave is selected. 

 

 Selecting either of these options adds to your current 
selection. So the concave surfaces are selected, as well as 
any previously selected components. 

You can use this dialog with the new Minimum radius plane list, 
which is located in Tools > Options > View > 3D Graphics. This list 
enables you to shade the model from the perspective of the 
Workplane (the default setting) as opposed to the View (the default 
setting in previous versions of PowerMILL). 
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Editing the width of toolpath lines 
There is a new option on the Drawing page of the Options dialog 
which enables you to edit the line width of the toolpath in pixels. 
This enables you to increase the visibility of toolpaths when 
presenting on large screens.  

 
To display the Drawing page, from the main menu, select Tools > 
Options > Toolpath and select the Drawing page. In the Line Width 
field, enter the width of the toolpath line in pixels. 
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PowerMILL 2015 R2 contains the following changes and 
improvements to automation: 

 Macro enhancements (see page 61) — Display entities and hide 
GUI items when you use mode toolbars. 

 Macro Debugger enhancements (see page 62) — Edit variable 
assignments in the Macro Debugger dialog. 

 

Macro enhancements 
PowerMILL 2015 R2 includes new parameters to improve the 
efficiency of user-menu macros. The parameters enable PowerMILL 
to: 

 identify the last selected entity; and 

 display the total number of selected entities and the entity 
PowerMILL is currently processing. 

You can use the parameters to write macros that instruct 
PowerMILL to execute specific lines of code before and after it 
processes the first and last entity in a loop. Previously, PowerMILL 
could not identify the first and last entity so it executed the entire 
macro for every selected entity. 

You can use PowerMILL modes, such as the Curve editor or the 
Workplane editor, without displaying: 

 Toolbars 

 Mode-toolbars 

 Dialogs 

 Graphics 

Use the NOGUI command to run the equivalent of GRAPHICS LOCK 
when the mode starts. 

Automating PowerMILL 
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 For more information, see the 'Macro Programming Guide'. 
 

Macro Debugger enhancements 
Use the Enter parameter value dialog to edit variable assignments in 
the Macro Debugger.  

 
To display the Macro Debugger dialog, in the Explorer, right-click: 

 the Macro menu and select a macro to debug; or 

 a macro and select Debug. 

The left pane shows the macro you are debugging. The right pane 
shows the variable assignment at that point in the macro.  

To edit a variable assignment:  

1 In the right pane, double click a variable assignment. 

2 Enter a value in the Enter parameter value dialog. 

 

3 Click  to accept the changes and close the dialog. 
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